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SUMMARY
To reproducibly count the numbers of mRNAs in individual oocytes, single molecule RNA fluorescence in situ hybridization (RNA-FISH) was optimized for non-adherent cells. Oocytes were collected, hybridized with the transcript specific probes, and quantified using an image quantification software. 

ABSTRACT
Current methods routinely used to quantify mRNA in oocytes and embryos include droplet digital reverse-transcription polymerase chain reaction (RT-PCR), quantitative, real-time RT-PCR (RT-qPCR) and RNA sequencing. When these techniques are performed using a single oocyte or embryo, low-copy mRNAs are not reliably detected. To overcome this problem, oocytes or embryos can be pooled together for analysis; however, this often leads to high variability amongst samples. In this protocol, we describe the use of fluorescence in situ hybridization (FISH) using branched DNA chemistry. This technique identifies the spatial pattern of mRNAs in individual cells. When the technique is coupled with Localize computer software, the abundance of mRNAs in the cell can also be quantified. Using this technique, there is reduced variability within an experimental group and fewer oocytes and embryos are required to detect significant differences between experimental groups. Commercially available branched-DNA SM-FISH kits have been optimized to detect mRNAs in sectioned tissues or adherent cells on slides. However, oocytes do not effectively adhere to slides and some reagents in the kit were too harsh resulting in oocyte lysis. To prevent this lysis, several modifications were made to the FISH kit. Specifically, oocyte permeabilization and washes buffers designed for the immunofluorescence of oocytes and embryos replaced the proprietary buffers. The permeabilization, washes, and incubations with probes and amplifier were performed in 6-well plates and oocytes were placed on slides at the end of the protocol using mounting media. These modifications were able to overcome the limitations of the commercially available kit, in particular, the oocyte lysis. To accurately and reproducibly count the number of mRNAs in individual oocytes, computer software was used. Together, this protocol represents an alternative to PCR and sequencing to compare the expression of specific transcripts in single cells.

INTRODUCTION:
Reverse-transcriptase polymerase chain reaction (PCR) has been the gold standard for mRNA quantitation. Two assays, digital PCR (dPCR)1 and quantitative, real time PCR (qPCR)2 are currently used. Of the two PCR techniques, dPCR has greater sensitivity than qPCR suggesting that it could be used to measure mRNA abundance in single cells. However, in our hands, dPCR analysis of low abundance mRNAs in pools of 5 to 10 oocytes per each experimental sample has produced data with low reproducibility and high variation3.  This is likely due to the experimental error associated with RNA extraction and reverse transcription efficiency. RNA sequencing has also been performed using a single mouse and human oocytes4,5. This technique requires cDNA amplification steps required for the library generation which likely increases variability within an experimental group. Furthermore, low abundance transcripts may not be detectable. Although sequencing prices have gone down since the last few years, it can still be cost prohibitive due to the high cost of bioinformatics analyses. Finally, mRNA localization is a dynamic process with spatial changes contributing to protein function6. Therefore, we set out to adopt a technique that would produce accurate and reproducible quantitative measures and localization of individual mRNAs in single oocytes. 

Branched DNA coupled to fluorescence in situ hybridization amplifies fluorescence signal rather than amplifying RNA/cDNA enabling detection of single mRNAs in individual cells 7–9. The assay is performed through a series of hybridization, amplification (using branched DNA), and fluorescence labeling steps in order to amplify the fluorescence signal7. The technique begins with binding of 18- to 25-base oligonucleotide probe pairs that are complementary to a specific mRNA3,8,10. Fifteen to twenty probe pairs are designed for each transcript ensuring specificity for the target transcript. The mRNA-specific hybridization is followed by pre-amplifier and amplifier probes that form a branched configuration. Approximately, 400 label fluorophores bind to each amplifier, resulting in an 8000-fold increase in fluorescence allowing detection of individual mRNAs (Figure 1)11. 

[Place Figure 1 here]. 

Previous studies using single molecule fluorescence in situ hybridization (SM-FISH) localized -actin mRNAs in individual neurons12 and human papillomavirus DNA in cervical cancer cell lines7. The computer software Spot Finding and Tracking Program identifies individual punctate fluorescent signal and has been successfully used to quantify the number of mRNAs in each cell3,13.  

Based on the results of mRNA detection in neurons12, we hypothesized that SM-FISH would prove a useful tool to quantitate transcript levels in murine oocytes and embryos including low abundance mRNAs. However, the technique is optimized for the use with adherent fixed cells and formaldehyde fixed paraffin embedded (FFPE) tissue sections. Oocytes cannot adhere to a slide, even when they are coated with Poly-L-lysine. Furthermore, they are more fragile than somatic cells and tissue sections resulting in cell lysis when subjected to some of the proprietary buffers in commercially available kits3. To overcome these challenges, oocytes were fixed and manually transferred between drops of the buffers. Furthermore, permeabilization and wash buffers in the kits were replaced to reduce the cell lysis. Predesigned probes are purchased alongside the FISH kit or specific transcripts can be requested. Each proprietary probe set is available in one of three fluorescence channels (C1, C2, and C3) to allow for multiplexing.  In the current experiment, murine oocytes were dual-stained and quantified using a C2 Nanog probe and a C3 Pou5f1 probe. These probes were selected based on the reported expression of Nanog and Pou5f1 in oocytes and embryos. At the conclusion of the hybridization steps, oocytes were placed in drops of anti-fade mounting media for application to histological slides. Confocal images were used to quantify the number of punctate fluorescent signals which represent individual mRNAs. In addition to quantifying the mRNAs, imaging also showed the spatial distribution of the specific mRNA in the cell, which other RNA quantification methods are unable to achieve. This technique proved to have low variability within an experimental group allowing the use of smaller numbers of oocytes in each experimental group to identify significant differences between experimental groups3.  

PROTOCOL
Animal procedures were reviewed and approved by the Institutional Animal Care and Use Committee at the University of Nebraska-Lincoln and all methods were performed in accordance with relevant guidelines and regulations.  For this study, CD-1 outbred mice had ad libitum access to normal rodent chow and water; they were maintained in a 12:12 dark: light cycle.

1. Preparation of required media

1.1. For base media (OMM), add 100 mM NaCl, 5 mM KCl, 0.5 mM KH2PO4, and 1.7 mM CaCl2-2H2O to 100 mL sterile water. 

NOTE: OMM medium can be stored for up to 1 month.

1.2. For complete media (OMOPS), add 20 mM 3-morpholinopropane-1-sulfonic acid (MOPS), 1.2 mM MgSO4-7H2O, 0.5 mM glucose, 6 mM L-lactate, 1 mM ala-gln, 0.1 mM taurine, 1x non-essential amino acids (NEAA), 0.01 mM ethylenediaminetetraacetic acid (EDTA), 10 µM alpha lipoic acid, 10 µg/mL undiluted gentamicin, 21 mM 1 M NaOH, 5 mM NaHCO3, 0.2 mM Pyruvate, 0.5 mM Citrate, 4 mg/mL FAF BSA to a 1:10 dilution of OMM in sterile water for a total volume of 100 mL. Sterilize the medium with a 0.22 µM filter. 

NOTE: OMOPS can be stored for up to 1 week. 

1.3. For the holding medium (HM) add 5% fetal bovine serum to OMOPS.  Make 2 mL HM per mouse.

1.4. For hyaluronidase solution add 0.1 mg/mL of hyaluronidase derived from bovine testes, to 1 mL HM. 

1.5. For the fixation buffer combine 4% paraformaldehyde in 10 mL of 1x PBS along with 0.1% embryo grade polyvinylpyrrolidone (PVP)14.

1.6. To prepare 50 mL wash buffer (WB), add 0.1% non-ionic surfactant and 0.1% PVP to 1x PBS14.

1.7. To Prepare 10 mL permeabilization buffer, add 1% non- ionic surfactant to 1x PBS14. 

NOTE: The wash and permeabilization buffers described above replace the proprietary buffers in the commercially available kits.

2. Collection of ovulated oocytes from female mice

2.1. Preparation: 

2.1.1. Stimulate female mice at 5-8 weeks of age by intraperitoneal (IP) injection of 5 IU equine chorionic gonadotropin (eCG) followed by 5 IU human chorionic gonadotropin (hCG) 44-48 h later15,16.  

2.1.2. Keep 35 mm Petri dishes containing 2 mL of HM on a 37 °C warming plate. Pipette one, 100-µL drop of HM containing diluted hyaluronidase followed by three, 50 µL drops of HM without hyaluronidase in a 60 mm petri dish. Place plates containing drops on the 37 °C warming plate prior to use. 

NOTE: The hyaluronidase drops should be made just prior to the dissection of each oviduct pair to prevent the evaporation and concentration of the components of HM with or without hyaluronidase.  

2.2. Euthanize mice, 16 h after the IP injection of hCG, using isoflurane overdose followed by cervical dislocation.

2.3. Clean the mouse using 70% ethanol. Expose the abdominal cavity and visualize the female reproductive tract. Hold the ovary with forceps and remove the uterine ligaments and excess adipose tissue from around the ovary. Cut the oviduct from the uterus and place the ovary-oviduct pair in the warm HM in the 35 mm dish.  

2.4. Remove the ovary and any surrounding adipose tissue. Tear the swollen ampulla of the oviduct using a ½ inch 27-gauge needle. Push the oviduct at the site of the tear and the cumulus cell-oocyte complexes (COCs) will be expelled. Transfer the ovulated oocytes, which are presumed to be in metaphase II (MII) of meiosis, to the 100 L drop containing HM media with hyaluronidase using a mouth pipette (Figure 2). 

[Place Figure 2 here] 

2.5. Pipette the MII oocyte-cumulus cell complexes up and down in the hyaluronidase containing HM with the mouth pipette to dislodge cumulus cells. Transfer each oocyte, once they are devoid of cumulus cells to a wash drop containing HM only using the mouth pipette. Repeat this for each wash droplet. Do not transfer fragmented or transparent oocytes15.

NOTE: It is important to transfer the oocytes from each drop in the 35 mm dish with as little HM as possible. This is true for every transfer in the protocol. The MII oocytes must not remain in the hyaluronidase containing HM medium for more than one minute.    

3. SM-FISH Staining of Oocytes

3.1. Fix oocytes in an individual well of a 6-well plate containing 500 µL of Fixation Buffer. Submerge 20 oocytes or less in the well.  Incubate for 20 min at room temperature. 

NOTE: Each SM-FISH staining step occurs within an individual well in a 6-well conical plate.  Ensure that oocytes are completely submerged in buffers and not floating on top of the buffer.  Each step should be performed with 20 oocytes or less in each well.

3.2. Transfer fixed oocytes to 500 L of wash buffer (WB described in step 1.6) for 10 min each. Repeat 2 more times.

3.3. Incubate oocytes in permeabilization buffer for 30 min at room temperature. 

NOTE: The permeabilization buffer described in step 1.7 replaces the propriety permeabilization buffer.  

3.3.1. Gather probe sets and quickly spin them down in a microcentrifuge. Warm each probe set for 10 min in a 40 °C water bath or incubator. Cool to the room temperature. 

NOTE: This step should be performed during the permeabilization incubation
 
3.4. Wash oocytes in 500 µL of WB for 10 min at room temperature.  

3.5. Transfer oocytes to 80 L of Protease III Buffer (available from the kit), that is diluted 1:8 in 1X PBS, for 30 min at room temperature. 

NOTE: The 80 µL volume adequately covers the bottom of an individual well in a 6-well plate.

3.6. Wash oocytes in 500 µL of WB for 10 min at room temperature.

3.7. Dilute the warmed probe sets for Nanog, Pou5f1, and DapB (a negative control gene), 1:50 in probe diluent. Incubate oocytes in 80 L of the transcript-specific probe for 2 hours at 40° C. 

NOTE: Each proprietary probe set is available in one of three fluorescence channels (C1, C2, and C3). The Nanog and Pou5f1 probes were tagged with C2 and C3, respectively.

3.8. Warm the proprietary, Amplifier 1 (AMP 1), Amplifier 2 (AMP2), Amplifier 3 (AMP3) and Amplifier 4-fluorescence (AMP 4-FL) at room temperature.

NOTE: This step should be performed during the 2-hour transcript-specific probe incubation.

3.9. Transfer the oocytes to 500 L of WB and incubate for 10 min at room temperature.

3.10. Incubate oocytes sequentially in amplification buffers. 

3.10.1. Incubate oocytes in 80 µL of AMP1 for 30 min at 40° C. Transfer oocytes to 500 µL of WB for 10 min at room temperature.  

3.10.2. Incubate oocytes in 80 µL of AMP2 for 15 min at 40 °C.  Transfer oocytes to 500 µL of WB for 10 min at room temperature.  

3.10.3. Incubate the oocytes in 80 µL of AMP3 for 30 min at 40 °C. Transfer oocytes to 500 µL of WB for 10 min at room temperature. 

NOTE: The remainder of the protocol is performed in the dark because AMP-FL contains the fluorophore. When working under the dissecting microscope, reduce the light as much as possible.

3.10.4. Add oocytes to 80 L of AMP4-FL for 15 min at 40° C. 

NOTE: AMP4-FL is provided as alternative buffer-A (Alt-A), Alt-B or Alt-C. Select the AMP4-FL buffer dependent on which emission wavelength is desired. 

3.11. Wash oocytes in 500 µL of WB for 10 min at room temperature. Incubate oocytes in 80 µL of DAPI for 20 min at room temperature. Wash oocytes in 500 µL of WB for 5 min at room temperature.

3.12. Pipette 12 µL of anti-fading mounting media onto the center of a slide without adding bubbles to the reagent. Transfer oocytes with as little WB as possible into the mounting media and apply a coverslip. 

3.12.1. Tilt the coverslip at an angle and slowly and gently place over the liquid on the slide. Avoid pressing the coverslip too hard to prevent distortion of the oocytes and introduction of bubbles. 

3.12.2. Store the slides in a dark box to dry overnight at room temperature. Coat the edges of the slides in clear nail polish to seal coverslip.

3.13. Use a standard microscope to find oocytes on the slide and circle with a permanent marker. 

NOTE: This step is not required but improves locating oocytes on the slide. For best results, image slides within 1 to 5 days as the fluorescent signal will begin to fade.  

4. Image Processing

4.1. Image the 3-dimensional oocytes, using z step confocal microscopy. 

NOTE: To accurately analyze the images, each z step should be 1.0 µm/slice. 

4.2. Save confocal images as a compressed nd2 or individual .TIFF files for each oocyte. Both image types are compatible with the open source image processing program, Fiji. 

4.3. Download and install the open access Fiji software (https://imagej.net/Fiji/Downloads). 

4.3.1. Drag nd2 files into Fiji and choose hyperstack. If confocal images were saved as .TIFF files skip to step 4.4. 

NOTE: When the nd2 file is dropped into Fiji the hyperstack dropdown should appear automatically. 

4.3.2. Click the Image tab, Select Color, and click Split Channels to separate the fluorescent channels of the nd2 file.

4.3.3. Generate individual .TIFF files for each z-slice of the oocyte in each fluorescent channel. Click the Image tab, select Stacks, and click Stack to Images.  Click the Image tab, select Type, and click RGB Color to convert each z slice to an individual RGB color image. 

NOTE: The RGB color is artificial and can be chosen as desired for each emission wavelength.

4.3.4. Save each converted image as .TIFF file. Place images from a single oocyte for each fluorescent channel in a new folder to avoid confusion during stitching (step 4.3).

4.4. Normalize each .TIFF image for Pou5f1 and Nanog using negative control images (DapB). 

NOTE: Normalization is performed using a photo editing program. Make sure to remove the same levels of background fluorescence from each control image.

4.5. Open each normalized .TIFF file in Fiji to stitch together all z-slices for each oocyte in each wavelength. 

4.5.1. Click the Plugins tab, select Stitching, and click on Grid/Collection (Figure 3A). Select Sequential Images from the drop-down menu and click OK (Figure 3B). 

4.5.2. Browse the directory and select the folder containing all of the z-slice images for an individual oocyte at one wavelength (see step 4.3.4). Click OK.

4.5.3. Move the slider at the bottom of the stitched image to the appropriate color channel for the wavelength used and create the final RGB stitched image by clicking Image, selecting Type, and click RGB Color. 

NOTE: This image will be used for fluorescence quantitation described in step 4.6 below.  

4.6. Convert the stitched image to 32-bit maximum projected picture. Click Image, select Type, and click 32-bit (Figure 3C). Save this image as a new .TIFF file.  

[Place Figure 3 here]

4.7. Download and install the Spot Finding and Tracking Program 13, which is available from the website for D.R. Larson, an investigator at the National Institutes of Health National Cancer Institute (https://ccr.cancer.gov/Laboratory-of-Receptor-Biology-and-Gene-Expression/daniel-r-larson). Download and install the open access virtual machine for the interactive data language (IDL) operating system which is required to run the Spot Finding and Tracking Program (http://www.spacewx.com/pdf/idlvm.pdf).  

4.8. Open the 32-bit, stitched image, which was generated in step 4.6 (Figure 4A), in the Spot Finding and Tracking Program.  Select the Localize dropdown and click Localize (Figure 4B), which will calculate the number spots found in the image.

NOTE:  Each spot counted represents an individual mRNA. Band pass and photon threshold settings are shown in the screenshot (Figure 4B). For this protocol, default for each threshold setting was used. Representative positive and background spots are shown (Figure 4C).

[Place Figure 4 here]


REPRESENTATIVE RESULTS
Upon the completion of the protocol, the result will be individual images from confocal z-series (Figure 4A and 5), stitched images (Figure 4C), and mRNA counts (Figure 4B).  When multiplexing is performed, there will also be merged images showing the label for two different mRNAs (Figure 5). The mRNA counts are generated using stitched images generated by Fiji (Figure 3) and the punctate fluorescence spots counted using the Spot Finding and Tracking Program (Figure 4B). 

The mRNA counts are subsequently analyzed using a standard data analysis tool.  In this protocol, we labeled n=12 oocytes with Pou5f1 and Nanog. The results for each mRNA are averaged and the standard error of the mean calculated. The data collected in this protocol showed 775 ± 26 SEM Pou5f1 transcripts and 113 ± 5 SEM Nanog transcripts in MII oocytes (Figure 5). A student’s t-test determined a statistically significant difference in mRNA counts between Pou5f1 and Nanog. Importantly, there were no spots detected in n=5 oocytes that are labeled with DapB probe (i.e., negative control). Note the small standard error using just 12 individual oocytes.  The sensitivity of the assay is also emphasized by positive reproducible detection of Nanog (Figure 5). Previous dPCR experiments did not reproducibly detect Nanog indicating that the number of Nanog mRNAs in an individual oocyte is below the threshold detection using dPCR 3. 

In pilot experiments, we detected reduced fluorescence if there was a delay between fixation of oocytes and initiation of the SM-FISH protocol. Likewise, if the proprietary hybridization buffers are not used, the probe and amplification branched DNA do not enter the cell resulting in fluorescence ringed around the plasma membrane of the oocyte.  This is likely due to aggregation of the branched DNA. Ringed fluorescence around the oocyte membrane will also result if there is poor permeabilization of the plasma membrane. Optimal degradation of protein bound to mRNAs is also required. The protease buffer provided in the SM-FISH kit is at an optimal concentration for treatment of tissue sections and adherent cells. However, when using non-adherent cells, it is important to empirically identify the best protease dilution. Too little protease buffer could result in undercounting of mRNAs due to poor accessibility of the probe to the mRNA.  Likewise, too much protease may result in degradation of not only proteins bound to the mRNA but also destabilization of the mRNAs. In this protocol, we tested mRNA detection using a titration curve of undiluted (1:1), 1:4, 1:8, and 1:12 diluted protease buffer in 1x PBS (n=2 to 3 oocytes per dilution). The average fluorescent expression of Pou5f1 mRNA in MII oocytes was 169 ± 42 SEM (undiluted), 176 ± 36 SEM (1:4), 308 ± 18 SEM (1:8), and 445 ± 24 SEM (1:12) (Figure 6). Protease dilution used in this protocol was 1:8 as it showed the lowest variation.

[Place Figure 5 here] 

[Place Figure 6 here].  


FIGURE LEGENDS
Figure 1: Schematic of the SM-FISH protocol. Sequential hybridization of transcript specific probe, branched DNA amplifier and fluorophore to a target mRNA is shown.

Figure 2: Parts of the mouth pipettor used to transfer oocytes. (A) mouth piece (B) 0.22 um, 4mm filter (C) aspirator tubing (D) 1000 L pipet tip (E) 9” Pasteur pipet.

Figure 3: Stitching together of confocal z-series images of oocytes. (A) Screenshot showing the Plug-in Grid/Collection tool in Fiji that was used to produce composite images of the oocyte.  (B) Sequential Images uses fluorescence overlap between sequential .TIFF files to generate a composite image.  (C) The composite image was saved as a 32-bit .TIFF file.

Figure 4: Quantification of mRNAs using Spot Finder and Tracking.  (A) Individual z-series images were stitched together as described in Figure 3 and saved as a 32-bit maximum projected .TIFF file. (B) Composite image was opened in Spot Finder and Tracking. Localize was used to count the fluorescent spots (red box). Band pass and photon threshold are indicated by the blue box. (C) The blue arrow points to a positive signal (above threshold). The white arrow shows a fluorescent spot below the threshold and, therefore, not counted.  

Figure 5: Pou5f1 and Nanog mRNA in MII oocyte.  (A). Representative images of the middle z-series image are shown on the left. Pou5f1 is detected in the red (647 nm) wavelength while Nanog is detected in the green (488 nm) wavelength. DAPI staining of chromosomes aligned on the metaphase II spindle, characteristic of the MII oocyte, is shown in white. There was no staining for DapB in either the 647 nm or 488 nm emission wavelength. (B) The number of Pou5f1 and Nanog mRNAs are shown as mean  SEM (n=12 oocytes); there was no detection (N.D) of DapB. * indicates P<0.05, Scale bar is 10 µm.

Figure 6: Empirical titration of protease buffer to optimize accurate counting of mRNAs. Representative images of SM-FISH of Pou5f1 in MII oocytes. DAPI staining shows chromosomes aligned on the MII spindle. Oocytes were incubated with undiluted (1:1), 1:4, 1:8, or 1:12 dilutions of Protease III buffer. The number of Pou5f1 mRNAs (n=2-3 oocytes) were counted and the mean  SEM is shown. Scale bar is 10 µm. 

Figure 7: Transfer of MII oocytes through fixation, protease, and hybridization buffers in wells of a 6-well plate.  The shape of each well is shown. (A) Cells float when first added to buffers (B) Submersion of oocytes in buffers. (C) Oocytes settle to the bottom of the well during the incubation period. 

DISCUSSION
A series of minor steps during the protocol will ensure successful fluorescence and accurate counts of mRNAs. First, the protocol must be performed immediately after collection and fixation of the oocytes. Note that PVP is added to the 4% paraformaldehyde fixation buffer to prevent oocytes from sticking to each other. We found that it is necessary to perform the experiment immediately after the collection and fixation of the oocytes. Any delay results in a much lower fluorescence signal that would result in undercounting of transcripts. This is due in part to RNA degradation. No more than 20 oocytes should be transferred to one well in the 6-well plate at one time and each well should only be used once.  Incubation times should also be accurately followed without shortening or lengthening of each step. The exception is the wash buffer steps; oocytes can be left in the wash buffer for a prolonged time without altering the experimental results. The SM-FISH probes are available in three fluorescence channels C1, C2, and C3.  For multiplexing, do not mix probes that have the same channel tag. This will result in both probes fluorescing at the same emitting wavelength rendering analysis impossible as there will be no way to distinguish between the probe sets. Positive control probes designed against housekeeping genes are available in each of the three channels. Negative control probes (e.g., DapB) are also available in premixed sets that contain a tag for all three channels. The experiment needs to be conducted in dim lighting as oocytes are light sensitive after removal from the oviduct17,18. After the addition of the fluorophores attached to AMP4, the steps should be performed with as little light as possible to prevent bleaching of the fluorophore. Finally, when mounting oocytes onto histological slides, carefully place the coverslip to prevent distortion of the oocyte and formation of bubbles which can interfere with imaging. If you find it difficult to avoid cell distortion, slide spacers should be used in order to maintain the spherical shape of the oocyte.

One essential modification of the protocol is the replacement of permeabilization, and wash buffers provided in the commercially available kit. The proprietary protease and hybridization buffers provided are harsh environments for the oocytes but are required for the success of the protocol.  If not used, the amplifiers are unable to enter the cell which is likely due to aggregation of the branched DNA. Moving the oocytes from these harsh environments to the relatively mild permeabilization and wash buffers, designed for immunofluorescence14, proved adequate for the success of the protocol and at the same time prevented lysis of the oocytes. Because oocytes and preimplantation embryos do not adhere to a histological slide, another essential modification was placing the oocytes into the buffers within a well of a culture dish. We used a 6-well embryo culture plate. Each well in the plate has tapered and sloped sides and an 8 mm flat bottom (Figure 7), which improves oocyte recovery. This is particularly important as oocytes lose their refractory properties and become almost transparent in the hybridization buffers. 

When transferring oocytes from well to well, it is important to ensure that the oocytes are fully submerged in the solutions in each well as cells will float when first transferred to each well (Figure 7A). Once they are mechanically submersed into the buffer (Figure 7B), they will sink to the bottom of the well by the end of the incubation (Figure 7C). The exception is AMP 1 and AMP 3; when mechanically submersed the oocytes do not completely settle to the bottom of the well. To find these oocytes, you may need to change the plane of focus. Pipette carefully and count the number of cells being transferred to prevent loss.

Multiple single molecule FISH techniques, that amplify the fluorescent signal rather than cDNA, including branched DNA chemistries, have been developed 9,19. Commercially available kits have optimized the branched DNA SM-FISH method for reproducible detection of individual mRNAs in tissue sections or adherent cells on a histological slide. The protocol described here has been modified for use with single non-adherent cells (e.g., oocytes and preimplantation embryos)3.  This enables not only specific and reproducible quantification but also localization of a mRNA within the oocyte.  While this is an advantage of the assay, there are of course limitations. For example, unlike RNA-sequencing, it cannot identify novel mRNAs. An additional limitation of the protocol is the availability of transcript-specific probes. Proprietary probes are commercially available from the companies that sell the SM-FISH kits. There are several probes that are pre-made. Others can be designed by the company for any annotated mRNA using an objective algorithm10. However, if a mRNA is poorly sequenced it would be difficult to design probes with high specificity. For short transcripts it can also be difficult to identify enough probe pairs that do not cross-react with other transcripts reducing the specificity of the assay. Likewise, a smaller number of probe sets may be insufficient to produce fluorescence signal above the threshold for detection as positive in the Spot Finding and Tracking Program. In this same vein, transcript variants cannot be detected with this method.

Despite the limitations described above, there are several applications for SM-FISH. For example, data from single cell RNA-sequencing could be validated especially when cell numbers are small and difficult to obtain (e.g., oocytes and embryos). Amplification of cDNA for PCR assays introduces an experimental error which is typically reduced by a normalization step using data from stably expressed housekeeping genes. However, temporal changes in oocyte through pre-implantation embryos also changes the expression of housekeeping genes. The SM-FISH protocol amplifies fluorescence instead of cDNA. Therefore, there is no requirement for normalization of transcript-specific mRNA levels to obtain reproducible results with low variability. Due to the variability of PCR primer efficiency, differences in the absolute numbers of different mRNA species cannot be accurately compared within or between cell types. SM-FISH localizes and quantifies mRNA. Therefore, it can be used to identify which cells express mRNA in a mixed cell population. For example, when oocytes are growing within primary or secondary follicles, the follicle can be isolated and cultured in alginate beads20 but the separation of the oocyte from somatic cells is difficult. Therefore, sequencing and PCR studies have been performed using mixed cell populations. The use of SM-FISH can determine if mRNAs are detected in somatic cells or the oocyte of the follicle. Finally, SM-FISH has high sensitivity and specificity allowing for detection of low abundance transcripts; for example, detection of Nanog in MII oocytes (Figure 5).  

[bookmark: _GoBack]Storage and degradation of mRNAs are important regulatory mechanisms for protein expression. Post-transcriptional regulation of translation, storage, and degradation are mediated by proteins that bind to mRNAs21. Currently, RNA-protein immunoprecipitation (RIP) can be routinely performed when a large number of cells are available22. Due to the large number of Xenopus eggs that can be collected from a single animal, RIP has been successfully performed in this animal model.  However, it is difficult to obtain enough mammalian oocytes and pre-implantation embryos to perform RIP. Coupling of SM-FISH and immunofluorescence (immunoFISH) 23 of tissue sections hold the potential to visualize proteins associated with specific mRNAs including translational machinery24,25. Genomics measure genetic variants (e.g., small nucleotide polymorphisms, SNPs) associated with health and disease26. Phenomics identifies changes in cellular responses due to environmental pressures27,28. Current research aims to find the mechanism that connects changes in the genome with specific phenotypes. The use of immunoFISH has the potential to link SNP-dependent changes in mRNA expression and the expression of proteins that contribute to cellular phenotypes. As the technology evolves, there are likely other applications of SM-FISH that will identify important mechanisms in multiple biological systems.
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